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1. Introduction
eProof fi les are self-contained PDF documents for viewing on-screen and for printing. They contain all appropriate formatting 
and fonts to ensure correct rendering on-screen and when printing hardcopy. DJS sends eProofs that can be viewed, annotat-
ed, and printed using the free version of Acrobat Reader 7 (or greater). These eProofs are “enabled” with commenting rights, 
therefore they can be modifi ed by using special markup tools in Acrobat Reader that are not normally available unless using 
the Standard or Professional version.
The screen images in this document were captured on a PC running Adobe Acrobat Reader version 8.1.0. Though some of 
the images may differ in appearance from your platform/version, basic functionality remains similar. At the time of this writing, 
Acrobat Reader v9.1 is freely available and can be downloaded from: http://get.adobe.com/reader/

2. Comment & Markup toolbar functionality

A. Show the Comment & Markup toolbar
The Comment & Markup toolbar doesn’t appear by default. Do one of 

 the following:
  • Select View > Toolbars > Comment & Markup.
  • Select Tools > Comment & Markup > Show Comment
    & Markup Toolbar.
  • Click the Review & Comment button in the Task toolbar, and choose
     Show Comment & Markup Toolbar.
 To add or remove tools for this toolbar, right-click the toolbar and select the tool. 
 Or, select Tools > Customize Toolbars.

B. Select a commenting or markup tool
 Do one of the following: 
  • Select a tool from the Comment & Markup toolbar.
  • Select Tools > Comment & Markup > [tool].
 Note: After an initial comment is made, the tool changes back to the Select tool 
 so that the comment can be moved, resized, or edited. (The Pencil, Highlight 
 Text, and Line tools stay selected.)

C. Keep a commenting tool selected
 Multiple comments can be added without reselecting the tool.
 Select the tool to use (but don’t use it yet). 
  • Select View > Toolbars > Properties Bar. 
  • Select Keep Tool Selected. 

Annotating PDFs
ams_annotating_pdfs1.1; April 09, 2009; full release

Choose Tools > Customize Toolbars to remove
unnecessary items from the toolbar

(see Section 7 for suggested toolbar layout)

Ch T l C t i T lb t

A. Sticky Note tool; B. Text Edits tool; C. Stamp tool; D. Highlight Text tool; E. Callout tool; F. Text Box tool; G. Various Object tools; H. Pencil tool

A B C D E F HG

3. The Properties bar
The Properties bar can be used to format text and select options for individual tools.
To view the Properties bar, do one of the following:
 • Choose View > Toolbars > Properties Bar.
 • Right-click the toolbar area; choose Properties Bar.
 • Select [Ctrl-E]
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4. Using the comment and markup tools
To insert, delete, or replace text, use the Text Edits tool. Select the Text Edits tool, then select the text with the cursor (or 
simply position it) and begin typing. A pop-up note will appear based upon the modifi cation (e.g., inserted text, replacement text, 
etc.). Use the Properties bar to format text in pop-up notes. A pop-up note can be minimized by selecting the     button inside it.

A

B

C

D

E

A. Attached fi le; B. Highlighted text; C. Crossed-out (strike-through) text; D. Inserted text; E. Replaced text

5. Inserting symbols or special characters
An ‘insert symbol’ feature is not available for annotations, and copying/pasting symbols or non-keyboard characters from Mi-
crosoft Word does not always work. Use angle brackets < > to indicate these special characters (e.g., <alpha>, <beta>).
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7. Summary of main functions
Insert text - Use Text Edits tool (position cursor and begin typing)
Replace text - Use Text Edits tool (select text and begin typing)
Delete text - Use Text Edits tool (select text and press delete key)
Highlight text - Use Highlight Text tool (select text)
Attach a fi le - Use the Attach a File with Comment tool (select tool, position 
                      cursor and click mouse, select fi le)

Suggested toolbar layout

Use the Comments list to review all changes

8. Reviewing changes
To review all changes, do the following: 
  • Select the Show button on the Comment & Markup toolbar.
  • Select Show Comments List.
   Note: Selecting a correction in the list will highlight the corresponding item in the document, and vice versa.

6. Editing near watermarks and hyperlinked text
eProof documents often contain watermarks and/or hyperlinked text. Selecting characters near these items can be diffi cult us-
ing the mouse alone. To edit an eProof which contains text in these areas, do the following: 
  • Without selecting the watermark or hyperlink, place the cursor near the area for editing.
  • Use the arrow keys to move the cursor beside the text to be edited.
  • Hold down the shift key while simultaneously using arrow keys to select the block of text, if necessary.
  • Insert, replace, or delete text, as needed.
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ABSTRACT

The Super Outbreak of tornadoes over the central and eastern United States on 3–4 April 1974 remains the

most outstanding severe convective weather episode on record in the continental United States. By nearly

every metric imaginable, the outbreak far surpassed previous and succeeding events in severity, longevity, and

extent. In this paper, surface, upper-air, radar, and satellite data are used to provide an updated synoptic and

subsynoptic overview of the event. Emphasis is placed on identifying the major factors that contributed to the

development of the three main convective bands associated with the outbreak, and on identifying the condi-

tions that may have contributed to the outstanding number of intense and long-lasting tornadoes. Selected

output from a 29-km, 50-layer version of the Eta forecast model, a version similar to that available operationally

in the mid-1990s, also is presented to help depict the evolution of thermodynamic stability during the event.

1. Introduction

ThAU1 e Super Outbreak of tornadoes of 3–4 April 1974

remains the most outstanding severe convective weather

episode on record in the continental United States (FF1 ig. 1).

By nearly every metric imaginable, the outbreak far sur-

passed previous and succeeding events in severity, lon-

gevity, and extent. A sampling of statistics only partially

conveys its enormity: 148 tornadoes, of which 95 were F2

or stronger and 30 were F4 or F5; 48 killer tornadoes

resulting in 335 deaths and more than 6000 injured;

pathlengths up to 145 km (90 mi), with a total path-

length .4000 km (2500 mi); F2s or greater present for

each three hour period between 1200 UTC 3 April and

1500 UTC 4 April; 15 tornadoes in progress simulta-

neously at the height of the event; and 10 states declared

federal disaster areas. Further appreciation for the phe-

nomenal nature of the Super Outbreak may be gleaned

from F F2ig. 2, which depicts the maximum, week-long run-

ning total of F2 or greater tornadoes from 1915 through

2008. Entire years noted for their prominent tornado

counts (e.g., 1947, 1953, and 2003) pale in comparison to

the 18-h period that began around midday on Wednes-

day, 3 April 1974. Twenty-five F3 or greater long-track

[.40 km (25 mi)] tornadoes occurred during the same
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period, more than triple the annual average of such events

since 1880 (Broyles and Crosbie 2004).

More than a third of a century has passed since the Super

Outbreak inflicted its toll on the Midwest and the Ohio and

Tennessee Valleys. Despite its breadth and intensity, little

has been written about lessons that the forecast and re-

search communities might learn from the event. From this

perspective, it is important to ask what characteristics of

the synoptic- and mesoscale environments might have

made the April 1974 outbreak so extraordinary, and how

this analysis might be used to anticipate such a rare event in

the future. In particular, it is incumbent upon severe

weather forecasters to attempt to understand why so many

significant, long-lasting tornadic storms occurred.

FIG. 1. Tracks of the 148 Super Outbreak tornadoes documented by Fujita (1975). Areas affected by tornadic

supercells composing convective bands one, two, and three are depicted in dark, medium, and light gray shading,

respectively. (See section 3 for discussion of convective bands one, two, and three.) The tornado in southwestern NY

was an isolated event loosely associated with band two.
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In the present paper, surface and upper-air analyses as

well as radar and satellite data are used to provide an

updated synoptic- and subsynoptic-scale overview of the

1974 Super Outbreak. Emphasis is placed on 1) identi-

fying the major factors involved in the development of

the four convective bands associated with the event and

2) identifying the conditions that may have contributed

to the outstanding number of intense and long-lasting

tornadoes. Given the paucity of radar and satellite data

relative to that routinely available today, discussion nec-

essarily focuses on mesoalpha- and mesobeta-scale as-

pects, with only limited mention of storm-scale processes.

2. Data

Plots of twice-daily (0000 and 1200 UTC) mandatory-

level rawinsonde observations over the United States

and adjacent parts of Canada and Mexico for 2 April–

4 April 1974 were hand analyzed in a conventional

manner; the analyses for the period 1200 UTC 2 April–

1200 UTC 4 April are provided in FF3 ig. 3. The decision to

perform a hand analysis reflected 1) a desire to minimize

the effects of smoothing inherent in objective analysis

schemes and 2) the belief that hand analysis can serve to

further one’s familiarization with and understanding of

meteorological events.

Plots of hourly surface observations over the central

and eastern United States also were manually analyzed

for the period 1200 UTC 2 April–1200 UTC 4 April

1974. A selection of these analyses is presented in FF4 ig. 4.

Although their inclusion substantially lengthens this pre-

sentation, examination of the long-term evolution of sur-

face (and upper level) features is essential to understanding

this event. The observed data (station plots) appear in

each analysis. The data are too small for clear display on

the printed page, but are legible when viewed with mag-

nification on a computer monitor. The data density is

sufficient to enable the reader to critique the analyses.

Emphasis during the surface analysis process was

placed on identifying subsynoptic-scale wind and ther-

modynamic discontinuities believed to be important to

thunderstorm initiation, and on tracking these features

consistently over space and time. Most of the disconti-

nuities were characterized conventionally as cold fronts,

warm fronts, drylines, and outflow boundaries, etc. Wind

shift lines, short-lived troughs, and other features that

appeared to be of lesser significance or of unknown or-

igin were denoted by dashed lines. One discontinuity

had characteristics of both a cold front and a dryline; this

feature is discussed in section 3. The 3-hourly analyses

presented in Hoxit and Chappell (1975) provided a valu-

able first guess for the period from 1200 UTC 3 April

through 0300 UTC 4 April. Large-scale, hourly, manu-

ally digitized radar composite charts from the Storm

Prediction Center (formerly the National Severe Storms

Forecast Center) archive assisted in the identification of

thunderstorm outflow boundaries, as did radar data

presented in Forbes (1975), and plotted storm reports

contained within the Storm Prediction Center database.1

Because the Super Outbreak occurred just prior to the

launch of the first geosynchronous weather satellite in

May 1974, the temporal and spatial resolutions of the

satellite data covering the event are quite limited rela-

tive to those routinely available today. The analyses did,

however, benefit from 29 hard-copy, national-scale Ap-

plications Technology Satellite-III visible data images for

the period from 1342 to 2324 UTC 3 April; a few of these

images appear in Fig. 4.

To depict the spatial evolution of thermodynamic sta-

bility during the outbreak, selected output fields from a

29-km, 50-layer version of the Eta forecast model (here-

after ‘‘Eta29’’), are presented. The model, similar to that

used operationally by the National Weather Service

(NWS) in the mid-1990s (Black 1994), was initialized with

data valid at 0000 UTC 3 April. It uses a modified Betts–

Miller cumulus parameterization scheme (Betts 1986,

FIG. 2. Maximum, week-long running total of F2 or stronger tornadoes per year since 1915.

Data from Grazulis (1993). (Graphic courtesy of H. Brooks, NOAA/National Severe Storms

Laboratory.)

1 Because severe weather report gathering efforts in 1974 were

very limited relative to those of today, it should be recognized that

the number of nontornadic severe events for the Super Outbreak

likely far exceeds that indicated by the Storm Prediction Center

database.
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FIG. 3. Sequence of 250-, 500-, 700-, and 850-hPa manual upper-air analyses for (a) 1200 UTC 2 Apr, (b) 0000 UTC

3 Apr, (c) 1200 UTC 3 Apr, (d) 0000 UTC 4 Apr, and (e) 1200 UTC 4 Apr 1974 over the continental United States.

Conventional data plots using metric units, except wind speed, which is in knots (1 kt 5 0.51 m s21). Wind speeds

equal to or greater than 35 m s21 (70 kt) are shaded purple at 250 hPa; dewpoints greater than or equal to 48C are

shaded green at 850 hPa. Troughs are depicted by dashed black lines at 700 hPa. The states of Kansas and Missouri

are shaded for reference.
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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FIG. 3. (Continued)

Fig(s). 3 live 4/C
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Janjić 1994), with initial and boundary conditions provided

by the National Centers for Environmental Prediction–

National Center for Atmospheric Research (NCEP–

NCAR) global reanalysis dataset (Kalnay et al. 1996AU2 ). The

reanalysis dataset is on a 2.58 3 2.58 grid with 17 levels.

Model forecast fields, rather than reanalysis data, were

chosen to depict the spatial stability because of the coarse

nature of the reanalysis data, and to provide a 3-hourly

regional evolution of the thermodynamic environment

between the routine 0000 and 1200 UTC rawinsonde

observation times. Use of the Eta29 primarily reflected

that model’s availability at the time the preliminary work

was being conducted on this project in spring 2004. Be-

cause the present paper focuses on the synoptic- and

mesoalpha-scale aspects of the Super Outbreak, little

benefit would be derived from presenting thermodynamic

or kinematic fields from a higher-resolution model, es-

pecially considering that such a model would be initial-

ized with the same low-resolution (global reanalysis) data.

Subjective evaluation of model mass fields revealed

that the Eta29 provided excellent forecasts of major

synoptic-scale features, including the position and in-

tensity of the lee cyclone and accompanying midlevel jet

streak associated with the event. Development of wide-

spread convective precipitation in the model appeared to

impact the Eta29’s thermodynamic fields after 2100 UTC.

Prior to that time, however, the model’s stability fields are

believed to be reasonably representative of the actual

thermodynamic environment over the central and east-

ern United States.

3. Chronological overview of the event

In this section, surface and upper-air analyses, as well

as radar and satellite data, are used to provide an upda-

ted synoptic- and subsynoptic-scale overview of the 1974

Super Outbreak. To date, no such overview has appeared

in the refereed literature. Given the limited amount of

radar and satellite data available relative to that rou-

tinely collected today, our discussion necessarily focuses

on mesoalpha- and mesobeta-scale features.

a. Morning through afternoon, Tuesday, 2 April

The morning of Tuesday, 2 April 1974, was charac-

terized by a broad, low-amplitude mid- and upper-level

trough over the continental United States (Fig. 3a).

Embedded in the trough were two moderately strong

short-wave disturbances that were apparent at both 700

and 500 hPa. One of these extended from the upper

Ohio Valley into the southern Appalachians, while the

other was over the Great Basin. The latter impulse was

accompanied by 500-hPa wind speeds of 50 m s21

(100 kt) across southern California, while downstream

speeds were less than 25 m s21 (50 kt) over the southern

plains. The eastern short wave was deamplifying at this

time and was associated with a weakening surface and

850-hPa low over northern Lake Huron (Figs. 3a and 4a).

Trailing generally south from the surface low, a cold

front extended along the western slopes of the Appala-

chians into the northwestern Gulf of Mexico. Thunder-

storms that formed along and ahead of the front on the

!
FIG. 4. Sequence of hand-analyzed surface charts for the central and eastern United States for (a) 1200 UTC

2 Apr, (b) 1800 UTC 2 Apr, (c) 0000 UTC 3 Apr, (d) 0300 UTC 3 Apr, (e) 0600 UTC 3 Apr, (f) 0900 UTC 3 Apr,

(g) 1200 UTC 3 Apr, (h) 1500 UTC 3 Apr, (i) 1800 UTC 3 Apr, ( j) 2100 UTC 3 Apr, (k) 0000 UTC 4 Apr, (l) 0300

UTC 4 Apr, (m) 0600 UTC 4 Apr, (n) 0900 UTC 4 Apr, and (o) 1200 UTC 4 Apr 1974. Conventional data plots

using English units, with wind speed in knots, and data believed to be erroneous enclosed in rectangles. Green lines

depict the 568, 628, and 688F (13.38, 16.68, and 20.08C) isodrosotherms; green shading indicates areas with dew-

points $ those values. (Note that in a few instances, isodrosotherms are drawn slightly awry to minimize data

obscuration.) Frontal symbols are conventional, with outflow boundaries depicted using small pips. Wind shifts

lines, short-lived troughs, and lesser features of uncertain origin are denoted by dashed lines. Axes of relatively

concentrated convection (per composite radar data, satellite data, and/or surface imagery) are shown by solid lines

without pips. Convective bands one, two, three, and four are indicated by large black numerals. Mesohighs

(‘‘bubble highs’’) are denoted by scripted Bs. Visible Applications Technology Satellite III satellite imagery, and

National Weather Service composite radar data (adapted from Hoxit and Chappell 1975), are included in (g)–(k);

the exact times of these products are given in the lower-left corner of each view. The composite radar images

depict echo tops in thousands of feet (last two digits omitted), echo motions (arrows with speed in knots). Scal-

loping denotes subjectively determined areas of scattered (circle with a single line) and broken (circle with

a double line) echo coverage. IP, S, RW, and TRW denote, respectively, ice pellets, snow, rainshowers, and

thunder showers, based subjectively on radar reflectivity data. Isolated is indicated by ISOLD. Severe weather

reports (as contained in the Storm Prediction Center database) for the 3-h period beginning at the surface analysis

time included in (g)–(o). Tornadoes and/or tornado tracks are in red, accompanied by the highest F-scale rating for

the event. Hail $ 1.9 cm (0.75 in.) is depicted by green dots, damaging wind and/ or observed wind gusts $25

m s21 (50 kts) by blue crosses, and combined wind and hail events by purple dots. (Note that severe weather

report gathering efforts in 1974 were very limited relative to those of today; the number of nontornadic reports for

this event likely far exceeds that indicated by the figures.)
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Fig(s). 4 live 4/C
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FIG. 4. (Continued)

Fig(s). 4 live 4/C

16 W E A T H E R A N D F O R E C A S T I N G VOLUME 0

JOBNAME: WAF 0#00 PAGE: 16 SESS: 8 OUTPUT: Tue Feb 16 00:09:08 2010 Total No. of Pages: 45
/ams/waf/0/waf2222297

W
ea

th
er

 a
nd

 F
or

ec
as

tin
g 

 (P
ro

of
 O

nl
y)



FIG. 4. (Continued)

Fig(s). 4 live 4/C
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afternoon and evening of 1 April produced a substantial

outbreak of severe weather over the Ohio, Tennessee, and

lower Mississippi Valleys. The region affected was nearly

identical to that which would subsequently experience the

Super Outbreak and included three F3 tornadoes, four

fatalities, and numerous injuries. The storms continued

through the night over the Southeast, generating co-

pious low-level outflow. This allowed the convection to

propagate well ahead of the front. By sunrise the storms

and composite outflow boundary extended from east-

ern North Carolina to southwest Georgia (Fig. 4a). The

thunderstorms finally weakened over the Gulf of Mex-

ico and north Florida during the afternoon.

b. Evening, Tuesday, 2 April

By late in the day on Tuesday, 2 April (0000 UTC

3 April), the Lake Huron low had moved into Quebec as

FIG. 4. (Continued)
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FIG. 4. (Continued)

Fig(s). 4 live 4/C
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the upper impulse continued northeastward into Canada

(Fig. 3b). The trailing cold front extended through a low

off the New England coast into southern Virginia and

the southern Appalachians (Fig. 4b). Surface dewpoints

south of the boundary were moist for the time of the

year, ranging from around 168C (low 60s 8F) in north

Florida to 218C (low 70s 8F) over coastal Louisiana. The

western part of the front had begun to advance north-

ward as a diffuse warm front through the Tennessee and

lower Mississippi Valleys in response to strong lee cy-

clogenesis in eastern Colorado (Fig. 4b). Development

of the low reflected increasing westerly flow aloft and

the eastward advance of the Great Basin upper impulse.

Cyclogenesis also was fostered by strong, along-stream

variation of the upper-level flow (Uccellini and Johnson

1979); 250-hPa speeds at this time ranged from nearly

70 m s21 (140 kt) in southern Nevada to less than

40 m s21 (80 kt) in Oklahoma and north Texas.

FIG. 4. (Continued)
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The jet maximum associated with the Great Basin

short-wave trough continued to move east- southeast

Tuesday evening as a weak lead disturbance (most ap-

parent in the temperature fields at 700 and 500 hPa)

reached central Oklahoma (Fig. 3b). At the same time,

the lee cyclone deepened to less than 984 hPa and edged

eastward into Kansas (Fig. 4c). Frontogenesis down-

stream from the low led to the development of a sta-

tionary front that extended east-northeast into southern

Michigan. Scattered high-based thunderstorms developed

across north Texas and southern Oklahoma early in the

evening; these are depicted schematically by the solid line

near the Red River in Fig. 4c and by the dash–dot line in

F F5ig. 5a. The storms formed in the vicinity of a dryline that

trailed southward from the Kansas low and likely reflected

the presence of increasing large-scale ascent with the lead

upper impulse. The storms grew more numerous later in

the evening upon encountering the northwestern fringe of

FIG. 4. (Continued)
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FIG. 4. (Continued)

Fig(s). 4 live 4/C
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returning Gulf moisture over northeast Texas and south-

east Oklahoma. The resulting convective system contin-

ued east-northeast into Arkansas and southern Missouri

early on Wednesday, 3 April, producing isolated severe

hail and wind gusts in the Red River Valley.

The thermodynamic environment across the central

and eastern United States late on Tuesday (0000 UTC

3 April) was dominated by a broad swath of steep low- to

midtropospheric lapse rates that extended from the

southern and central Rockies into the mid- and lower

Mississippi Valley (F F6ig. 6a). Lapse rates were nearly dry

adiabatic in the deeply mixed boundary layer over

western Texas, western Oklahoma, and southwest

Kansas. Farther east, this air mass was present above the

boundary layer as an elevated mixed layer (EML) over

the Ohio and Tennessee Valleys. While EMLs origi-

nating over the high plateau of the southwestern United

States and Mexico commonly are observed in soundings

FIG. 4. (Continued)
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FIG. 4. (Continued)

Fig(s). 4 live 4/C
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taken over the plains and Mississippi Valley prior to

spring tornado outbreaks, the areal extent of the EML in

this case (and its potential to yield a broad region of

potential instability) is notable. Nevertheless, because of

the absence of substantial boundary layer moisture,

significant surface-based convective available potential

energy (CAPE) at this time was confined to the region

along and south of the warm front over Louisiana and

Mississippi (FF7 ig. 7a).

c. Early morning, Wednesday, 3 April

The combination of potent dynamic forcing and favor-

ably timed diurnal factors promoted substantial strength-

ening and broadening of the south-southwesterly low-level

jet over the lower Mississippi Valley during the early

morning (0600–1200 UTC) of Wednesday, 3 April. During

the predawn hours, 850-hPa wind speeds increased to

more than 25 m s21 (50 kt) (Fig. 3c) across Louisiana,

FIG. 4. (Continued)
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FIG. 4. (Continued)

Fig(s). 4 live 4/C
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FIG. 4. (Continued)

Fig(s). 4 live 4/C
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FIG. 4. (Continued)

Fig(s). 4 live 4/C

28 W E A T H E R A N D F O R E C A S T I N G VOLUME 0

JOBNAME: WAF 0#00 PAGE: 28 SESS: 8 OUTPUT: Tue Feb 16 00:15:40 2010 Total No. of Pages: 45
/ams/waf/0/waf2222297

W
ea

th
er

 a
nd

 F
or

ec
as

tin
g 

 (P
ro

of
 O

nl
y)



FIG. 4. (Continued)

Fig(s). 4 live 4/C
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FIG. 4. (Continued)

Fig(s). 4 live 4/C
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FIG. 5. Schematic diagrams showing approximate locations, for the times indicated, of

convective bands (a) one, (b) two, and (c) three. Locations are based on NWS composite

radar data, visible satellite imagery, and surface observations.
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Mississippi, and Alabama as the Kansas low deep-

ened to 980 hPa (Fig. 4g) and the main upper impulse

continued east-northeastward into eastern Kansas

and Oklahoma. The associated northward transport

of moisture resulted in rapid warm sector destabili-

zation from the Gulf coast to the Tennessee Valley. By

1200 UTC, surface-based CAPE of 1000 J kg21 was

present as far north as the Ohio River (Fig. 7b), as the

Tennessee–lower Mississippi Valley warm front re-

developed north into western Kentucky and extreme

southern Illinois (Figs. 4e–g). However, because of

the presence of the EML (implied by the steep 850–

500-hPa lapse rates shown in Fig. 6b), most of the high

CAPE area was ‘‘capped’’ to unassisted, deep, con-

vective development.

Although the EML prohibited the development of

surface-based thunderstorms over most of the warm

sector early in the day, steep lapse rates within the EML

and the presence of increasingly rich moisture just beneath

it were favorable for the production of cold convective

downdrafts from existing storms. This thermodynamic

setup, in conjunction with the presence of fast, largely

unidirectional cloud-layer flow, fostered continued over-

night intensification and organization of the Arkansas

and Missouri thunderstorms. By dawn (approximately

1200 UTC), composite radar data show that the storms

FIG. 6. Sequence of 29-km Eta 850–500-hPa lapse rates valid for (a) 0000 UTC 3 Apr, (b) 1200 UTC 3 Apr, (c) 1800 UTC 3 Apr, and

(d) 0000 UTC 4 Apr 1974. Lapse rate contour interval is 0.58C km21; lapse rates greater than 6.5 and 7.58C km21 are shaded orange and

red, respectively. Model initialized at 0000 UTC 3 Apr.
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had evolved into a strong, forward-propagating con-

vective system that extended in a broken band from

southern Illinois across far western Kentucky into

central Arkansas (Figs. 4g and 5a). The surface data in

Figs. 4d–g suggest that the convective complex likely

was at least partly elevated, with storms fed by the

strengthening and increasingly moist low-level jet atop

what had become a fairly well-defined mesohigh [de-

picted by the ‘‘B’’ (for ‘‘bubble’’) in Figs. 4d–g]. Storm

tops in Illinois, well north of the surface warm front,

exceeded 15 km (50 000 ft), indicative of the quality

of the returning Gulf moisture above the still-stable

boundary layer. The convective system, and subsequent

storms that evolved from its remnants later in the day,

constituted the first of the three bands of severe storms

that ultimately composed the Super Outbreak. Hereaf-

ter, this convective system will be referred to as con-

vective band one.2

Convective band one moved east-northeastward at a

modest pace during the night, averaging between 13 and

18 m s21 (25–35 kt) in Arkansas and southern Missouri

(Fig. 5a). Toward sunrise, however, the northern part

accelerated east-northeastward. The system continued

moving rapidly east-northeastward across the lower Ohio

Valley through early afternoon, with a forward speed of

nearly 30 m s21 (60 kt). The southern part of band one

also underwent acceleration, although somewhat later

FIG. 7. Sequence of 29-km Eta surface-based CAPE (red), and CIN (blue), valid at (a) 0000 UTC 3 Apr,

(b) 1200 UTC 3 Apr, (c) 1800 UTC 3 Apr, and (d) 0000 UTC 4 Apr 1974. CAPE is contoured at intervals of

500 J kg21. CIN is contoured at 25, 100, and 250 J kg21. CIN greater than 100 J kg21 is stippled blue. The model is

initialized at 0000 UTC 3 Apr.

2 In this paper, the term convective band is favored over ‘‘squall

line’’ to emphasize that the predominant convective mode re-

mained quasi-cellular rather than linear throughout the Super

Outbreak.

Fig(s). 7 live 4/C
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(around 1400 UTC), with the leading edge reaching

northwest Alabama by 1535 UTC (Fig. 5a). Radar data

(Fig. 4h) suggest that this occurred largely as a result of

the development of new storms in western Tennessee,

well ahead of existing activity in northeast Arkansas.

1) ORIGIN OF CONVECTIVE BAND ONE

Evidence exists that convective band one in some

manner may have been associated with a solitary gravity

wave or undular bore (Simpson 1997, p. 5; Locatelli et al.

1998) that moved eastward into the Tennessee and Ohio

Valleys during the late morning and early afternoon of

3 April, more or less in tandem with the convection.

Miller and Sanders (1980), for example, describe a per-

sistent, small-scale pressure perturbation that moved

from western Arkansas to the western slopes of the

Appalachians in conjunction with the convective band.

Supporting this notion, satellite data show an arc of what

appear to be midlevel clouds that moved rapidly east-

ward across the lower Mississippi and Tennessee Valleys

between sunrise and midday (Figs. 4g–i; the cloud band

in question extends from west-central Tennessee through

central Mississippi in Fig. 4g; an animated version of the

satellite data is available online at http://www.spc.noaa.

gov/publications/corfidi/74outbreak_slides/74loop.gif).

The images suggest that the arc emanated from near the

accelerating mesoscale convective system (MCS), and

was oriented parallel to it. The cloud arc, however, ex-

tended southward to near the Gulf coast, well beyond

the southernmost radar echo (Fig. 4g) in northern Mis-

sissippi. As the arc moved east, the northern part of the

original convective band remained active northeastward

into Pennsylvania, while the southern part developed

south into Tennessee, Mississippi, and Alabama, more

or less coincidental with passage of the arc.3

Further bolstering the idea that convective band one

may have been related to a solitary wave or undular

bore, Locatelli et al. (2002) present output from a me-

soscale model simulation of the Super Outbreak show-

ing a structure in the vicinity of the model’s depiction of

band one that has characteristics of a bore. In their

simulation, the feature moved east across the Ohio and

Tennessee Valleys in unison with the Arkansas MCS.

They propose that the borelike structure formed when

the lead (‘‘Pacific’’) cold front associated with the Kansas

surface low encountered the stably stratified, ‘‘loaded gun’’

type of thermodynamic environment over the southern

plains. This seems plausible, as the feature was oriented

roughly parallel to the model cold front and remained so

through its lifetime. However, the model bore moved

more slowly than the satellite-observed cloud arc. In

addition, because satellite imagery is not available prior

to 1342 UTC, knowledge of the arc’s origin relative to

the Arkansas MCS is open to speculation. Thus, the

nature of the arc cloud and its possible association with

a solitary wave or bore remain somewhat of a mystery.

What is certain, however, is that the storms that ulti-

mately evolved into convective band one formed dur-

ing the previous evening in Oklahoma and Texas in an

environment that was becoming increasingly favorable

for forward-propagating, quasi-linear convection (e.g.,

Corfidi 2003). The storms had grown into an organized

convective system well before the borelike structure

became apparent in the Mississippi Valley. Although

the bore may have indeed assisted the convective

development over the Tennessee and Ohio Valley re-

gion after sunrise on 3 April, it is not apparent that the

bore itself was responsible for the development of con-

vective band one, as Locatelli et al. (2002, p. 1644)

conclude. In fact, it appears that the bore itself may have

originated from the mesohigh associated with Arkan-

sas–Missouri complex.

2) COLD FRONT–DRYLINE DISCONTINUITY

IN THE OZARKS

West of convective band one, a boundary that exhibi-

ted characteristics of both a cold front and a dryline

reached southwest Missouri, western Arkansas, and north-

west Louisiana around 1500 UTC Wednesday (Fig. 4h;

depicted after 0900 UTC as a cold front).4 This disconti-

nuity appears to have evolved from two separate features:

a cold front that was associated with the aforementioned

lead upper-level impulse (evident in the 700- and 500-hPa

thermal fields shown in Fig. 3b) and a dryline that had

become discernible over western Oklahoma and central

Texas early Tuesday afternoon (Fig. 4b). Overnight, the

cold front overtook the dryline in Texas, while the

Oklahoma part of the dryline became obscured by out-

flow from the evolving convective cluster near the Red

River. With the onset of diurnal heating and increased

boundary layer mixing on Wednesday morning, the cold

front–dryline accelerated northeast across much of

the remainder of Missouri and Arkansas, reaching the

St. Louis area and northeast Arkansas around midday

(Fig. 4i). Wind gusts in excess of 20 m s21 (40 kt) and

sharply reduced visibility due to blowing dust followed

3 Miller and Sanders (1980) identify nine other perturbations in

the wake of the first. The latter features did not, however, bear any

consistent relationship with mesoalpha-scale convective development

later in the day.

4 To simplify the presentation, and because convective outflow

boundaries became less discernable after 1200 UTC, the convec-

tive bands are denoted schematically by solid lines in Figs. 4h–o.
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passage of the discontinuity across north Texas and

much of Arkansas. The dust is visible as light hazy areas

in the satellite images in Figs. 4i–k.

At the surface, the cold front–dryline gradually as-

sumed characteristics more typical of a classic dryline

(i.e., a marked east-to-west reduction in dewpoint and

a nominal change in temperature) as the feature moved

east of the Mississippi River later on Wednesday, and

continued eastward Wednesday night and into early

Thursday. Part of this behavior undoubtedly reflects the

influences of differential insolation and radiational cooling

rates across the boundary. Yet the position of the 700-hPa

thermal gradients and the wind shift axes at both 0000

and 1200 UTC Thursday, 4 April (Figs. 3d and 3e), rel-

ative to the surface discontinuity suggest that the feature

still retained some aspects of a cold front, at least at

700 hPa. ‘‘Hybrid’’ features of this type have been ob-

served by operational meteorologists in association with

other Colorado cyclogenesis events, and they can lead to

confusion or misplacement of frontal features in sub-

jective analyses [e.g., the 1200 UTC Thursday surface

analysis in Hoxit and Chappell (1975), taken from the

official NWS Daily Weather Map]. Remarkably, this

particular drylinelike boundary remained identifiable

through 1200 UTC Thursday as far northeast as central

Ohio (Fig. 4o), distinct from the main synoptic cold front

in Indiana.

More will be said about the Missouri–Arkansas cold

front–dryline in association with the discussion on the

development of convective band two in section 3d(2).

d. Late morning/early afternoon, Wednesday, 3 April

Diurnal heating, occurring nearly simultaneously with

the arrival of substantial low-level moisture, resulted in

continued destabilization across much of the east-central

and southeastern United States late Wednesday morn-

ing. By midday and primarily through vertical mixing,

the Tennessee Valley warm front—largely a moisture

discontinuity—had re-formed north into northern Illinois

and central Indiana, not very far south of the synoptic-

scale stationary front in southern Michigan (Fig. 4i).

Part of the old boundary, however, remained stalled

along the eastern slopes of the southern Appalachians,

where overnight storms retarded its northward move-

ment. As Fig. 7c shows, by 1800 UTC surface-based

CAPE in excess of 2500 J kg21 was present from the

lower Ohio and Mississippi River Valleys, south and

east to the Gulf coast and Georgia, while values were

greater than 3500 J kg21 over parts of Alabama, Mis-

sissippi, Tennessee, and Kentucky. In addition, because

of the well-mixed nature of the boundary layer, and the

‘‘quality’’ of the moist inflow [surface dewpoints of 188–

208C (mid- to upper 60s 8F), well above seasonal norms;

precipitable water $32 mm (1.25 in.)], values of the mean

mixed layer CAPE were nearly as great (not shown).

1) FRACTURE OF CONVECTIVE BAND ONE

The northern part of convective band one continued

to race east-northeast across the Ohio Valley through

midafternoon, reaching western Pennsylvania by 1930

UTC. The convective system produced the first tornado

of the Super Outbreak, a brief touchdown northwest of

Indianapolis, Indiana, at around 1430 UTC.5 The

southern part, meanwhile, reached eastern Tennessee

around 1630 UTC (Fig. 5a), and produced the first F3

tornado of the event near Cleveland, Tennessee (east of

Chattanooga), around 1905 UTC (track 113 in Fig. 1).

The southern part of band two became more difficult to

discern around this time as additional storms formed in

its vicinity, possibly along outflow boundaries left by the

overnight storms (Fig. 4i). In summary, convective band

one appeared to break into two main parts between 1500

and 1800 UTC, with the split centered over eastern

Kentucky.

Hoxit and Chappell (1975) attribute the fracture of

band one to its movement into a zone of large-scale

subsidence centered over eastern Kentucky at 0000 UTC

4 April, based on their kinematic analysis of rawinsonde

data. However, it is also worth noting that strengthening

and backing of the 850-hPa winds over the southern and

central Appalachians during the day likely contributed

to localized enhancement of the downslope flow over

eastern Kentucky and western West Virginia (Figs. 3c

and 3d).

Although downslope flow and the background verti-

cal motion field may have had some influence on the

evolution of convective band one, other factors likely

were important as well. For example, the surface and

upper-air environments (Figs. 3c and 4h) varied con-

siderably along the system’s latitudinal extent. Thus, one

might expect a concomitant along-line variation in the

intensity, character, and longevity of the convection

(e.g., Houze et al. 1990) in band one. Furthermore, if

some of the convection occurred in conjunction with an

undular bore (as previously discussed), the persistence

of a shallow but strong low-level inversion over the Ohio

Valley would have provided an efficient ducting layer to

allow for rapid forward motion of the bore, and for the

continued regeneration of elevated storms along its path

east-northeastward into Pennsylvania (Figs. 4h–j). Far-

ther south, meanwhile, rapid warming and moistening of

5 This brief event is not shown in Fig. 1 (from Fujita 1975), but

does appear in the Storm Prediction Center’s severe event data-

base and, therefore, is shown in Fig. 4g.
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FIG. 8. (left) Rawinsonde and (right) hodograph plots for Nashville at (a) 1200 UTC 3 Apr, (b) 1800 UTC 3 Apr, and

(c) 0000 UTC 4 Apr 1974. Sounding depicts temperature in red and dewpoints in green. Hodographs color coded for

height (0–3 km, red; 3–5 km, green; 6–9 km, black; 9–12 km, blue; greater than 12 km, purple); black numerals denote

height in km. Wind speeds on soundings and on range rings of hodographs are in kt. Black squares denote mean wind;

open circles with crosses indicate Bunkers et al. (2000) estimated right-mover storm motion.

Fig(s). 8 live 4/C
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the boundary layer may have disrupted the stability

profile that favored propagation of the bore and fostered

a transition toward surface-based convection over that

region by midday. This transition appears to have oc-

curred both in the wake of the bore over the Cumberland

Plateau and ahead of it over the southern Appalachians.

The northern part of convective band one produced

scattered damaging wind gusts and marginally severe hail

in Ohio before weakening over Lake Erie and northwest

Pennsylvania late in the afternoon. The southern half,

meanwhile, remained active as it became indistinguishable

from the additional storms that formed over Mississippi,

Alabama, northern Georgia, and eastern Tennessee. In

addition to the Cleveland, Tennessee, F3 tornado, an F2

tornado with a 24-km (15 mi) pathlength occurred in ex-

treme northern Georgia around 1915 UTC (track 123 in

Fig. 1). Animated satellite data suggest that band one

(and/or the undular bore associated with it) served to

enhance an area of existing thunderstorms as it moved east

along the stalled frontal segment and outflow boundaries

over the southern Appalachians. However, given the ar-

rival of the convective band/bore at the time of maximum

diurnal heating, and the contemporaneous increase in

boundary layer moisture that was occurring, a causal re-

lationship cannot be made with certainty.

2) DEVELOPMENT OF CONVECTIVE BAND TWO

In the wake of the first band of convection, a second

area of thunderstorms, hereafter referred to as convec-

tive band two, formed around 1500 UTC in northeast

Arkansas and extreme southeast Missouri (Fig. 5b).

These storms appear to have been initiated as clearing

skies (note the fast eastward movement of dense clouds

associated with convective band one in satellite images

shown in Figs. 4g and 4h) and strong boundary layer

moisture transport very rapidly destabilized the region

of confluent low-level flow some distance ahead of the

cold front–dryline. Ascent associated with the southern

part of the lead midlevel short-wave trough also may

have played a role in fostering development (note the

12-h movement of the lead 700-hPa short-wave trough

in Figs. 3c and 3d; the location of the trough is based on

the leading edge of the associated thermal gradient and

the wind shift axis). It is also possible that channeling

of the low-level flow over northeast Arkansas (the ‘‘Delta’’

region of the Mississippi River Valley) may have assisted

in the storm development by locally enhancing moisture

transport and convergence.

The degree of destabilization that occurred in the wake

of convective band one and just ahead of band two is

apparent in the sequence of soundings made at Nashville,

Tennessee, shown in F F8ig. 8. Comparison of Figs. 8a and 8b

suggests that a combination of surface heating, moisture

inflow, sustained large-scale ascent, and perhaps cold

advection weakened the convective inhibition layer; by

early afternoon the sharp nose at the base of the EML

had been completely eroded. This trend was accompa-

nied by an increase in CAPE over the region (cf. Figs. 7b

and 7c). Meanwhile hodographs revealed wind profiles

that became increasingly favorable for tornadic super-

cells (e.g., Doswell 1991; Miller 2006; Esterheld and

Giuliano 2008) in the strengthening flow downstream

from the approaching upper-level jet streak (e.g., cf.

Figs. 8a and 8b, and note the ‘‘sickle shape’’ hodograph

FIG. 8. (Continued)

Fig(s). 8 live 4/C
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in Fig. 8b). Using an average observed storm motion of

2308 at 22 m s21 (45 kt), the 0–1-km storm relative

helicity at 1800 UTC in middle Tennessee was more

than 230 m2 s22.

Given the environment of very strong [35 m s21

(70 kt)] 0–6-km shear with nearly unidirectional south-

westerly flow and moderate instability (surface-based

CAPE of 2000–3000 J kg21), the storms in convective

band two quickly became supercells. By 1800 UTC

(roughly noon local time), cloud tops within band two had

attained heights of more than 15.2 km (50 000 ft) in

western Kentucky, well above the regional morning tro-

popause level of 11.6 km (38 000 ft). Reflecting the ori-

entation of the axis of strongest flow aloft (from northeast

Arkansas to northern Indiana at 1800 UTC, given in-

terpolation between the 1200 UTC 3 April and 0000 UTC

4 April upper-air analyses), storms in the northern part of

the band moved rapidly northeastward, while those at the

trailing southern end edged only slowly eastward across

western Tennessee. Band two spawned the first F5 tor-

nado of the Super Outbreak, one that subsequently struck

the town of Depauw, in southern Indiana, around 1920

UTC (track 40 in Fig. 1). As the convective band moved

generally east-northeastward, it also expanded preferen-

tially to the north, so that by early afternoon it extended

from central Indiana to western Tennessee (Fig. 5b).

Examination of Eta Model height and vertical motion

fields (not shown), and the 1800 UTC rawinsonde data,

suggests that the presence of slightly stronger synoptic-

scale forcing for ascent (30–40 m, 12-h 500-hPa geo-

potential height falls) and weaker capping likely were

responsible for the northward bias in the development.

Throughout this period, the storms remained well east [by

about 300 km (200 mi)] of the cold front–dryline.

3) CONVECTIVE BAND TWO ASSOCIATED WITH

A COLD FRONT ALOFT?

Locatelli et al. (2002) call attention to a thermal gra-

dient at 700 hPa that extends from eastern Illinois and

western Indiana southsouthwestward into the lower

Tennessee Valley at 0000 UTC 4 April (Fig. 3d). They

note that the gradient is strongest just west of convective

band two, with the thermal contours oriented parallel to

the band. These observations, and output from a meso-

scale model simulation showing the presence of 700-hPa

cold advection over the Tennessee and lower Ohio Val-

leys, prompt the authors to conclude that convective band

two marked the leading edge of a ‘‘cold front aloft,’’

(CFA) as described by Locatelli et al. (1989) and Hobbs

et al. (1990). CFAs are believed to provide both ascent

and destabilization that can focus convective release in

regions of potential instability, and are akin to the ‘‘split

cold fronts’’ discussed by Browning and Monk (1982).

CFAs differ, therefore, from the upper-level fronts that

occur in association with jet streaks near the tropopause

(e.g., Keyser and Shapiro 1986).

The idea that convective band two may reflect

the presence of an upper-level boundary is to some extent

supported by the temporal and spatial continuity of the

700-hPa thermal gradient and wind shift axis as revealed

by the observed rawinsonde data in Figs. 3c and 3d. In-

terpolating between the 1200 UTC 3 April and 0000 UTC

4 April analyses, it seems probable that, for a period of

time around midday, weak 700-hPa cooling and, pre-

sumably, ascent associated with the trough overspread

western parts of the destabilizing warm sector some dis-

tance ahead of the cold front–dryline. An 18-h forecast of

surface pressure and 1000–500-hPa thickness from the 29-

km Eta Model (not shown) shows the axis of maximum

thickness to be located about 250 km (160 mi) from the

surface front in eastern Missouri and Arkansas. Lumb

(1950), among others, has suggested the use of the

thickness field to locate upper fronts ahead of surface

boundaries.

However, the observed data are not entirely consis-

tent with the behavior of a CFA as presented in the lit-

erature (e.g., Hobbs et al. 1990 and references therein).

For example, temperatures in the 700–500-hPa layer

warmed 28–48C during the day over much of the Ohio

and Tennessee Valleys (cf. Figs. 3c and 3d). And, while

modest geopotential height falls did occur during the

period at 700 mb, similar rises occurred at 500 hPa. A

vertical section taken from Omaha, Nebraska, and Way-

cross, Georgia, valid at 0000 UTC 4 April and shown in

Hoxit and Chappell (1975, their Fig. 49) shows, at best,

only a subtle hint of an elevated front near Nashville.

This is in contrast to the marked and deep upper-level

discontinuities depicted in the vertical sections shown

in Hobbs et al. (1990). Further, particularly along its

northern extent, convective band two at some points was

located up to 200 km east of the eastern-most ‘‘nose’’ of

the 700-hPa thermal gradient. Although the presence

of weak 700-hPa cold advection atop the western parts

of the warm sector during the early afternoon likely

served as a destabilizing influence, this cooling could

more simply be attributed to the existence of stronger

westerly momentum in the southeastern quadrant of the

vast Kansas upper low (Fig. 3c) relative to points farther

north, rather than to the existence of a CFA. The cooling

at 700 hPa also may have reflected the glancing in-

fluence of the lead short-wave impulse. Given the sparse

nature of the rawinsonde network and the sizable effects

of latent heating that necessarily occurred in associa-

tion with convective band two (e.g., Hoxit and Chappell

1975, p. 34), our analysis cannot provide independent

confirmation that band two was indeed associated with
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a CFA. Even if a CFA were present, it is not apparent

how vertical motions favorable for the initiation of deep

moist convection would evolve along it. Thus, while

there remains some doubt that a CFA was the dominant

agent of initiation for convective band two, it does ap-

pear that the band formed in a region that experienced

weak cooling at 700 hPa, and that the storms were not

directly related to the nearest long-lived surface feature,

the eastern Missouri–Arkansas cold front–dryline.

4) DEVELOPMENT OF CONVECTIVE BAND THREE

Shortly after convective band two arose in Arkansas and

southeast Missouri, a third broken line of thunderstorms,

convective band three, developed around 1600 UTC along

an arc extending north from near St. Louis into west-

central Illinois (Fig. 5c). Satellite- and model-derived

data suggest that band three formed in a zone of strong

differential positive vorticity advection associated with

the lead short-wave trough moving east-northeast into

the mid–Mississippi Valley, and in the immediate vicinity

of the eastern Missouri cold front–dryline. The convec-

tion formed in the left exit region of a 65 m s21 (130 kt)

250-hPa jet streak crossing the southern plains (Figs. 3c

and 3d). As convective inhibition was quite weak (per

1800 UTC Salem, Illinois, rawinsonde data; Fig. 8d) and

convergence was pronounced near the intersection of

the cold front–dryline and the Illinois warm front (Fig.

4i), storms formed as soon as the convective tempera-

ture was attained [about 238C (748F)]. Coupled with the

extreme 0–6-km shear across the region [more than

45 m s21 (90 kt) at Salem], it is not surprising that these

storms became supercells very quickly. By 1800 UTC,

tops had reached 15.2 km (50 000 ft). Baseball-sized

hail fell in central Illinois around 1720 UTC, and, shortly

afterward, wind-driven baseball-sized hail produced the

costliest storm damage ever up to that time in St. Louis

(NOAA 1974). About an hour later, the northern part of

band three dropped golf ball–sized hail in Chicago. The

first tornado with band three, an F0, lasted only a minute

and touched down near Morris, Illinois [about 70 km

(45 mi) southwest of Chicago] around 1810 UTC. How-

ever, by 1950 UTC, band three had produced two F3s:

one near Decatur and the other near Normal in east-

central Illinois (tracks 4 and 5 in Fig. 1).

5) DEVELOPMENT OF CONVECTIVE BAND FOUR

Approximately 1 h after convective band three formed

in eastern Missouri and central Illinois, a fourth area of

storms developed in northeast Missouri and eastern

Iowa. These storms appeared to mark the northern end

of the Missouri cold front–dryline, and formed south of

the stationary front extending northeastward from the

Kansas surface low. The convection organized into a bro-

ken south-southwest–north-northeast-oriented line that

moved slowly eastward across the Mississippi River into

northern Illinois during the afternoon. Although the

band weakened upon reaching the western suburbs of

Chicago (and rain-cooled air from band three) around

0000 UTC 4 April, it remained clearly visible in the grazing

illuminatio AU3n of the setting sun at 2324 UTC (Fig. 4k).

Forming as they did close to the upper low center

(Fig. 3d), and remaining well-removed from the surge of

rich boundary layer moisture that moved northward

ahead of convective band three, the storms in band four

were comparatively low topped; maximum tops were

uniform around 9–10 km (30 000–35 000 ft). This alti-

tude nonetheless represented a substantial relative pen-

etration of the local tropopause that, according to the

0000 UTC rawinsonde at Peoria, Illinois (not shown), was

around 7 km (22 000 ft). The storms produced margin-

ally severe hail in eastern Iowa and northwest Illinois, but

no observed tornadoes. The latter fact may reflect the

limited moisture (surface dewpoints around 128C) and

relatively weak low-level wind field that existed in the

region relative to points south and east.

Convective band four formed immediately ahead of the

deep synoptic-scale low moving slowly northeast from

Kansas into Iowa. Surface thermal, moisture, and wind

fields in the vicinity of the low and the convective band

display a structure and evolution more representative of

the frontal fracture (‘‘T bone’’) model of oceanic cyclones

described by Shapiro and Keyser (1990), than of the more

conventional warm front–cold front ‘‘triple point’’ pattern

depicted in Hoxit and Chappell (1975, 25–33). The visible

satellite data (i.e., Figs. 4j and 4k) support this idea, with

low overcast present north and west of the southern Iowa–

southern Wisconsin stationary front, and a break between

those clouds and the bands of convective towers extending

south along the Illinois cold front. The T-bone structure

had become apparent as early as sunrise on Wednesday

(1200 UTC; Fig. 4g). The absence of an identifiable triple

point is a common aspect of Colorado lee cyclogenesis,

although T-bone structures are not frequently observed. In

this case, the T-bone configuration may have been accen-

tuated by the fact that true warm sector air was not able to

reach the cyclone center because of the expanding bands

of deep convection that formed farther south and east.

e. Midafternoon, Wednesday, 3 April, through early
morning, Thursday, 4 April

The Super Outbreak began in earnest around 1900 UTC

(1400 CDT) as the three strongest convective bands began

producing damaging tornadoes more or less continuously,

and the number of severe weather warnings increased

accordingly (F F9ig. 9). During the next 2 h, devastating tor-

nadoes struck Depauw, Indiana; Brandenburg, Kentucky;
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and Xenia, Ohio (tracks 40, 47, and 37, respectively, in

Fig. 1); all of which were associated with band two. The

violence increased after 2100 UTC (Fig. 4j), as torna-

does associated with all three convective bands occurred

simultaneously in numerous communities from Alabama

and Tennessee northward into Illinois, Indiana, Ohio,

and Michigan. The metropolitan areas of Birmingham,

Alabama; Cincinnati, Ohio; Louisville, Kentucky; and

Windsor, Ontario, Canada, also were hit. In northern

Indiana, band three spawned a half-mile-wide F4 that

struck the town of Monticello around 2215 UTC (track 13

in Fig. 1). The tornadic storm occurred in association with

a subsynoptic low that evolved near the intersection of

band three with the Ohio Valley warm front (note the

south-southeasterly surface winds in west-central Indiana

in Fig. 4j). The tornado had a pathlength of nearly 175 km

(109 mi), the longest of any in the Super Outbreak.6

Farther south, hail up to the size of softballs accompanied

band two in northern Kentucky, where radar cloud tops

reached 19.8 km (65 000 ft).

The Kansas surface low began to fill slightly as it

tracked slowly northeastward to near Burlington, Iowa,

by 0000 UTC Thursday, 4 April (Fig. 4k). The low was

situated in the left-exit region of a 70 m s21 (140 kt)

250-hPa jet streak in northwest Arkansas. At 500 hPa,

a band of 50 m s21 (100 kt) southwesterly flow extended

from northeast Texas to southern Illinois. Midlevel

temperatures south and east of the jet streak, in the

general area of convective band two, warmed by 38–58C

during the day. Hoxit and Chappell (1975) attribute this

warming to a combination of diabatic processes (latent

heat release), warm advection, and subsidence on the

equatorward side of the upper jet.

By 0000 UTC 4 April the northern part of convective

band one had long since dissipated over New York and

Pennsylvania. The southern part, meanwhile, became

indistinguishable late in the day after interacting with

supercell storms that formed along the stalled front over

the western Carolinas (Fig. 5a). Farther west, band

three continued eastward across Illinois, Indiana, and

western Kentucky, where individual radar-observed

cell motions reached 30 m s21 (60 kt). The convective

system also developed northward into southern Michi-

gan and extreme southern Ontario, where several tor-

nadoes occurred between 0030 and 0130 UTC in

a region of confluent southeasterly surface flow imme-

diately north of the warm front and remnant sub-

synoptic low associated with the Monticello storm (Figs.

4k and 5c). Band three did not show appreciable

weakening until it encountered rain-cooled air over

parts of Ohio and central Kentucky around 0300 UTC

on Thursday.

While severe weather continued in conjunction with

band three into Wednesday night, after 2300 UTC, the

most intense activity shifted to areas south of the Ohio

River in association with band two (Fig. 5b). The west–

east breadth of the warm sector in this region was greater

than farther north, and the air was more moist, with

precipitable water around 40 mm (1.6 in.). In addition,

eastward progression of the main upper trough into the

Ohio Valley (Figs. 3d and 3e) allowed stronger flow aloft

FIG. 9. Number of severe thunderstorm (light gray) and tornado (dark gray) warnings issued

per hour by local NWS offices during the Super Outbreak. Time in hours central daylight time

(CDT; add 0500 for UTC), with the last two digits removed. Data are from Department of

Commerce (1974).

6 Subsequent to publication of the Super Outbreak Map (Fujita

1975), Fujita reclassified the original 195-km (121 mi) Monticello,

Indiana, tornado as two tornadoes separated by a brief downburst

near the town of Chalmers (Fujita 1978). The length figure given

here is for the second tornado, which continued without interruption

to near Valentine, Indiana, in the northeast part of the state.
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to overspread the region, enhancing deep shear. The

strengthening deep west-southwesterly winds, oriented

nearly parallel to the low-level foci of storm initiation

(weak elongating thunderstorm outflow boundaries; see

Fig. 2 and p. 1011 in Corfidi 2003) allowed supercells to

back-build and ‘‘train’’ across northern Alabama and

eastern Mississippi for an extended period of time (Fig.

5b). This setup proved favorable for strong, long-track

tornadoes, likely in part because it minimized the chance

that storms would quickly be undercut by their own out-

flow. In far northern Alabama, a tornado that reached F5

intensity and had a pathlength of 82 km (51 mi) moved

through Lawrence, Morgan, Limestone, and Madison

Counties between 0000 and 0030 UTC (track 96 in Fig. 1).

A second tornado that followed a nearly identical path

barely 0.5 h later was rated F4 (track 98 in Fig. 1). The

storms that produced these tornadoes remained intense as

they moved into Tennessee.

Rich moisture inflow persisted along the southern

end of band two through the evening, within an envi-

ronment of intense [40 m s21 (80 kt)] deep shear. Around

0200 UTC, a supercell that had formed in east-central

Mississippi spawned a devastating long-track [164 km

(102 mi)] F5 tornado that destroyed the town of Guin,

Alabama (northwest of Birmingham), and continued

northeast to near Huntsville (track 101 in Fig. 1). Farther

north in middle Tennessee, a separate cluster of violent

band two tornadoes swept rapidly northeastward into

southern Kentucky between 0100 and 0200 UTC. The

tornadoes diminished in Kentucky after around 0300

UTC, but severe weather continued in Tennessee beyond

midnight central time (0500 UTC), as the storms en-

countered rising terrain and residual outflow boundaries

in the far eastern part of the state (Fig. 4m). Embedded

supercells continued to produce damaging winds and

additional strong tornadoes until nearly dawn (1000

UTC) on Thursday northward into southern West Vir-

ginia and western Virginia (Figs. 4n, 4o, and 5b). The

events in the latter two states were extremely unusual

considering not only the time of day and their intensity,

but also the relatively low incidence of severe weather of

any kind in that region at that time of the year.

The last tornado of the outbreak, an F2, overturned

trailers and unroofed homes near Baton, North Carolina

[100 km (65 mi) east-northeast of Asheville] around

1345 UTC (track 148 in Fig. 1).

4. Discussion

This paper has presented an updated synoptic- and

mesoscale overview of the 3–4 April 1974 Super Out-

break of tornadoes. The outbreak was clearly singular in

terms of its intensity, longevity, and scope. It might be

expected that an event of such magnitude would be as-

sociated with a correspondingly rare, but readily rec-

ognized, synoptic-scale signature. This, however, is not

the case. For example, although the Colorado–Kansas

lee cyclone that formed prior to the Super Outbreak was

intense, its strength was not unprecedented; two or three

cyclones of similar magnitude might be expected each

decade. Further, the low weakened rather than inten-

sified during the course of the event. Aloft, a midtropo-

spheric jet streak had speeds in excess of 60 m s21

(120 kt), but similar features occur fairly regularly over

the United States during winter and spring. Likewise,

the thermodynamic instability, while substantial, was

not extreme; surface-based CAPE frequently exceeds

2000 J kg21 in the warm sectors of migratory spring

cyclones over the Ohio and Tennessee Valleys in spring.

What factors, then, likely contributed to the outstanding

nature of the Super Outbreak?

Instead of a single ‘‘smoking gun,’’ it appears that

several contributing factors, acting together more or less

synergistically, ultimately were responsible for the event.

First, and not to be discounted, the unusually strong upper-

level jet streak associated with the progressive Great Basin

trough set the stage for a severe weather outbreak by

creating large-scale conditions favorable for expansive lee

cyclogenesis east of the Rockies. The jet maximum not

only provided the necessary shear for intense, sustained

supercells, but also helped create mesoscale areas of as-

cent that assisted in the initiation of convection. In addi-

tion, the strength of the background wind field increased

the chance that any tornadoes that did form would be

strong and long tracked.

The relatively low-amplitude nature of the upper-

level flow over the central United States prior to 3 April

1974 appears to have been influential for several rea-

sons. The pattern enabled a broad, largely undiluted

EML plume to spread rapidly east from the southern

and central plateau across a broad swath of the lower

Mississippi, Ohio, and Tennessee Valleys. The presence

of the EML led to the development of an expansive area

of potential instability as the boundary layer warmed

and moistened beneath it. In addition, because the mid-

to upper-tropospheric flow was not strongly meridional,

mid- and upper-level clouds associated with the warm

conveyor belt (Carlson 1980) remained comparatively

sparse (e.g., satellite images in Figs. 4i and 4j). Thick

warm conveyor belt clouds often accompany cyclogenesis

in highly amplified regimes wherein the strongly backed

mid- and upper tropospheric flow taps moisture from the

subtropics. Such cloud cover can substantially diminish

warm sector diabatic heating and destabilization.

The jet pattern also minimized midtropospheric height

falls in the warm sector. The leading edge of an area of
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falling heights often is accompanied by a cold front or

wind shift line at the surface that serves as a source of low-

level linear forcing for ascent. The relative weakness of

such features in this event (except near the main surface

low with convective band four) helped ensure that many

of the thunderstorms that formed would remain discrete

or semidiscrete for extended periods of time.

For some time now it has been recognized that long-

track tornadoes occur predominantly with discrete or

semidiscrete supercells, rather than with solid lines or

clusters of storms. The importance of nonlinear storm

modes in fostering tornado development and longevity

has become especially apparent in more recent years as

the advent of composite radar data facilitated the exam-

ination of storm development and interaction on ex-

panded spatial and temporal scales. Model simulations

(e.g., Roebber et al. 2002) also have demonstrated the

role played by weak linear forcing in maintaining discrete

supercellular storms. The absence of strong linear forcing,

coupled with the strength and the low-amplitude nature

of the background wind field, likely discouraged rapid

evolution toward linear convective modes and enhanced

the potential for both tornado development and longevity

throughout the afternoon and evening of 3 April 1974.

In particular, over the Tennessee Valley on the evening

of 3 April, the juxtaposition of fast, nearly unidirectional

low- to midtropospheric flow with a deep, moisture-rich

environment fostered thunderstorm cold pools that not

only became elongated parallel to the mean flow, but also

remained weak (i.e., with minimal temperature differ-

ential between the cold pools and the unaffected warm

sector). As the cold pools became elongated, those por-

tions of their outflow boundaries that became oriented

parallel to the flow remained nearly stationary and served

as corridors of ‘‘echo training’’ for supercells (Corfidi

2003). With the production of cold, evaporatively driven

downdrafts minimized by the deeply moist environment,

undercutting of the storms by their own outflow also was

limited. This increased their longevity and likely was a

factor in the destructive, long-track tornadoes that struck

northern Alabama and eastern Tennessee after sunset on

3 April.

An indirect but no less important consequence of the

low-amplitude flow regime prior to 3 April 1974 was its

contribution toward the development of an unusually

broad, warm, and moist warm sector for early April. The

warm sector was established, in part, when the trailing

frontal system associated with the previous low-amplitude

upper disturbance failed to effect a significant airmass

change over the Southeast as Colorado cyclogenesis oc-

curred on 2 April (Figs. 4a–c). The expansive warm sector

that subsequently evolved enabled the simultaneous

occurrence of both dryline-related thunderstorms

(convective band two) and jet exit region–cold frontal

storms (convective band three) as the Great Basin

trough moved into the plains on the afternoon of 3 April.

Because of the typically more limited areal extent of

surface-based warm sectors with Colorado cyclones,

severe weather episodes associated with such lows in

the central United States frequently are confined to 1)

dryline/lee trough storms on the initial day of the low’s

movement away from the Rockies and 2) jet-exit region/

cold frontal activity on the succeeding one. Such was not

the case on 3 April.

Climatological data suggest another factor that may

have fostered the development of an unusually warm

and moisture-rich boundary layer over parts of the south-

ern and eastern United States on 3 April 1974. Mean

constant pressure charts for the previous 30 days using

the NCEP–NCAR reanalysis data (Kalnay et al. 1996 AU4)

depict strong, largely zonal flow over the continental

United States, with a persistent low-amplitude trough

over the Rockies and the Great Basin (F F10ig. 10a). Heights

and 1000–500-hPa thicknesses were above normal over

the southeastern states and northern Gulf of Mexico,

and below normal over the northern tier of states and

Canada (Figs. 10b–d). A review of the NWS’s Daily

Weather Maps (Weekly Series) for March 1974 reveals

that the anomalous pattern minimized deep cold frontal

penetrations into the Gulf of Mexico through most of

the month. This likely yielded a broader, warmer, and

perhaps deeper moist boundary layer than is normally

accessible to migrating synoptic-scale systems at this

time of year. This air mass moved very rapidly north-

ward, with minimal modification, as southerly flow in the

warm sector strengthened over the southern and eastern

United States early on 3 April.

The preceding observations are consistent with the

spectral analysis of atmospheric energetics for the

1 March–1 May 1974 period shown in F F11ig. 11. The curves

depict the relative amount of energy in wavenumbers 1–3

at 500 hPa averaged over the Northern Hemisphere.

During the last half of March, a disproportionate amount

of the energy was contained in wavenumbers 1 and 2; that

is, the hemispheric flow was strongly zonal. An abrupt

transition to a more highly amplified pattern is apparent

in early April, with a sharp reduction in the level of en-

ergy in wavenumbers 1 and 2, and a slight increase in

wavenumber 3. This pattern change was brought about, in

part, by the significant lee cyclogenesis event that oc-

curred in conjunction with the Super Outbreak.

Another factor behind the enormity of the Super Out-

break was the presence of relatively uncommon mesoscale

forcing mechanisms. For example, our analysis sub-

stantiates previous studies (Miller and Sanders 1980;

Locatelli et al. 2002) indicating the possible role of an

42 W E A T H E R A N D F O R E C A S T I N G VOLUME 0

JOBNAME: WAF 0#00 PAGE: 42 SESS: 8 OUTPUT: Tue Feb 16 00:20:55 2010 Total No. of Pages: 45
/ams/waf/0/waf2222297

W
ea

th
er

 a
nd

 F
or

ec
as

tin
g 

 (P
ro

of
 O

nl
y)

stcorfidi
Sticky Note
Yes, et al. is correct; Thanks!



undular bore in the initiation and/or maintenance of

convective band one. The bore appeared to emanate

from the overnight MCS in Arkansas on 3 April and

provided an additional source of organized uplift through

the early afternoon. It likely helped initiate thunder-

storms deep within the warm sector in areas that may

otherwise have remained capped to such development.

In conjunction with daytime heating, the bore appeared

to help rejuvenate existing warm advection storms in

Georgia and the Carolinas. At the same time, a long-

lived subsynoptic low enhanced the potential for low-

level storm rotation and tornadoes as it tracked north-

eastward from northern Indiana into southeast Michigan.

Finally, circulations associated with a distinctly different

mesoscale feature appeared to be responsible for focus-

ing the development of convective band two. Although

Locatelli et al. (2002) argue that these circulations were

associated with a CFA, our analysis was inconclusive in

that regard. Nonetheless, it remains clear that some me-

soscale process, or combination of different processes,

provided a quasi-linear corridor of reduced convective

inhibition that allowed the formation of this second con-

vective band. Due in part to these mesoscale forcing

mechanisms, for several hours during the afternoon of

3 April, four bands of severe storms simultaneously

were present over the east-central United States.

FIG. 10. (a) Mean 700-hPa geopotential height, 3 Mar–2 Apr 1974 (m, scale at right). (b) Mean 700-hPa geopotential height anomaly,

3 Mar–2 Apr 1974 (m, scale at right); anomaly based on years 1968–96. (c) Mean 1000–500-hPa thickness, 3 Mar–2 Apr 1974 (m, scale at

right). (d) Mean 1000–500-hPa thickness anomaly, 3 Mar–2 Apr 1974 (m, scale at right); anomaly based on years 1968–96. Data from the

NCEP–NCAR reanalysis, courtesy of NOAA/Earth Systems Research Laboratory.

Fig(s). 10 live 4/C
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A final, but most significant factor contributing to the

singular nature of the Super Outbreak was that the di-

urnal cycle was favorably timed with respect to the arrival

of rich boundary layer moisture and the intensification of

deep shear over the Ohio and Tennessee Valleys. The

combination of increasing moisture, strengthening large-

scale forcing for ascent, and perhaps mesoscale forcing

mechanisms likely would have led to the eventual de-

velopment of severe thunderstorms along the system cold

front, and possibly along parts of the dryline and warm

front, even in the absence of diurnal heating on 3 April

1974. However, it is probably safe to speculate that the

intensity, longevity, and organization of the convection

would not have been as favorable for long-lived tornadoes

had the onset of heating not so directly corresponded with

the return of low-level moisture and shear.

In conclusion, this study does not provide the criteria

to ‘‘raise the red flag’’ that an extraordinary severe weather

outbreak is about to occur. Rather, it highlights the fact

that forecasting specific aspects of such an event (e.g.,

convective initiation, evolution, and mode) remains ex-

ceptionally challenging. Further, our review suggests that

a combination of well-known ingredients occasionally

can synergistically interact to yield an exceedingly rare

event.
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